
При проектировании высокоско�

ростных цифровых устройств, в от�

личие от цифровых устройств, рабо�

тающих на низкой рабочей частоте,

особое значение приобретает учёт ха�

рактера пассивных элементов цепи, в

том числе соединительных проводов,

печатных плат и корпусов интеграль�

ных схем, которые являются элемен�

тами конструкции цифрового устрой�

ства. На низких рабочих частотах эти

конструктивные элементы не оказы�

вают сколько�нибудь заметного влия�

ния на работу схемы. С повышением

рабочей частоты они начинают непо�

средственно влиять на электрические

характеристики схемы.

В теории проектирования высоко�

скоростных цифровых устройств ис�

следуется влияние пассивных эле�

ментов цепи на распространение

сигналов (переходные процессы и

отражения), взаимное влияние, ока�

зываемое сигналами друг на друга

(перекрёстные помехи), и их взаимо�
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Скорость передачи данных в современных печатных платах постоянно

растёт, и сегодня она может измеряться в сотнях мегагерц (DDR) и даже

в гигагерцах (Ethernet), что накладывает особые требования

к конструкции и, соответственно, инструментам разработки

конструкции, т.е. САПР. В программе Altium Designer имеется модуль

Signal Integrity, который позволяет проводить анализ целостности

сигналов как на пост#, так и на предтопологическом уровне

проектирования. В данной статье рассматриваются вопросы

актуальности задачи обеспечения целостности сигнала и примеры

её решения в программе Altium Designer.

действие с окружающей средой (элек�

тромагнитные излучения). Стоит от�

дельно оговориться относительно тер�

мина «высокоскоростные цифровые

устройства»: бытует мнение, что их

определяет тактовая частота или час�

тоты сигналов, но в действительности

такие устройства характеризуются

скоростью нарастания и спада, т.е. ско�

ростью переключения цифрового сиг�

нала. Эта скорость постоянно увели�

чивается с появлением новых техно�

логий изготовления микросхем (см.

табл. 1); учитывая этот факт, даже те

разработчики, которые пока считают,

что вопрос обеспечения целостности

сигналов их не касается, в ближайшее

время столкнутся с этой проблемой

при переходе на микросхемы новых

серий.

Задачи целостности сигнала пре�

дусматривают рассмотрение циф�

рового сигнала как аналогового с

произвольными искажениями его

формы, которые вызваны физичес�

кими особенностями распростране�

ния сигнала в реальной конструкции

платы.

Два важных фактора влияют на рас�

смотрение проблем целостности сиг�

нала:

● повышение частоты ведёт к увели�

чению скоростей изменения токов

dI/dt и напряжений dV/dt в цепях

аппаратуры. Это означает, что проб�

лемы, не оказывающие никакого

влияния на низкочастотные проек�

ты, могут иметь катастрофические

последствия в проектах следующего

поколения быстродействующих уз�

лов;

● эффективное решение проблем це�

лостности сигнала базируется на

понятиях полных сопротивлений

межсоединений. Если мы имеем глу�

бокое представление о полном со�

противлении и сможем установить

при конструировании соответствие

параметров конструкции печатной

платы и соответствующих полных

сопротивлений, то можно устранить

проблемы целостности сигнала на

этапе проектирования. Для более

полного понимания этих факторов

рекомендуется ознакомиться с лите�

ратурой [2–4].

Результатами выполнения этих за�

дач являются:

● для концептуальной стадии – реко�

мендации относительно реализу�

емости требований технического

задания по быстродействию, реко�

мендации по выбору материалов и

технологии изготовления;

● для стадии схемотехнического про�

ектирования – уточнение требова�

ний к электрическим параметрам

микросхем, получение рекоменда�

ций по установке помехоподавляю�

щих элементов, получение реко�

мендаций по выбору корпусов мик�

росхем; платы и сборки печатного

узла;

● для стадии топологического проек�

тирования – выработка топологи�

ческих норм и рекомендаций для

трассировки платы, получение дан�

ных для расположения компонентов

на плате, определение требований к

шинам питания и заземления и ре�

комендации по их расположению,

Технология изготовления микросхем Время перехода (нарастание и спад) Быстродействие (рабочая частота)

TTL, HCMOS 11 нс 32 МГц

LS TTL 5,5 нс 64 МГц

FCT 1 нс 350 МГц

3.3V CMOS 500 пс 700 МГц

130 nm CMOS 200 пс 1750 МГц

90 nm CMOS 100 пс 3500 МГц

10 Gbps Serdes 25 пс 14 ГГц

Таблица 1. Серии современных цифровых микросхем и их быстродействие
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определение структуры МПП, опре�

деление требований к экранам и их

расположению [4].

Прежде чем приступить к изучению

возможностей программы Altium De�

signer для обеспечения целостности

сигналов и рассмотрению методик

анализа, стоит выделить те пробле�

мы, с которыми сталкиваются разра�

ботчики при проектировании плат на

современной элементной базе. Для

целей нашего обсуждения определим

нарушение «целостности сигнала»

как любое явление, способное небла�

гоприятно повлиять на способность

сигнала к передаче двоичной ин�

формации. В реальных, действую�

щих цифровых устройствах двоич�

ным сигналам присущи аналоговые

атрибуты, обусловленные сложным

взаимодействием многочисленных

элементов схемы – от выходных па�

раметров формирователя до согласо�

вания путей распространения сигна�

лов.

Основные виды неполадок:

● нарушения амплитуды. В число на�

рушений амплитуды входят «звон»

(колебания), спад вершины (умень�

шение амплитуды в начале импуль�

са) и уменьшение амплитуды по всей

длине импульса;

● искажения фронтов. Искажения

фронтов могут быть вызваны не�

удачной топологией печатной

платы, как описано ранее, непра�

вильным согласованием или даже

применением некачественных по�

лупроводниковых устройств. В

число искажений фронта входят

выбросы, скруглённый фронт,

«звон», затянутый фронт и другие

искажения;

● нестабильность фронтов. Неста�

бильность фронтов возникает, ког�

да в цифровом сигнале происходят

малые смещения фронтов от цикла к

циклу. Это может повлиять на точ�

ность соблюдения временных соот�

ношений и синхронизации в циф�

ровых системах;

● отражения. Отражения могут по�

явиться вследствие неправильного

согласования и неудачной тополо�

гии печатной платы. Исходящий сиг�

нал отражается в направлении ис�

точника и накладывается на следу�

ющие импульсы;

● перекрёстные помехи. Перекрёст�

ные помехи возникают, когда

длинные проводники проходят

рядом; это приводит к связи между

ними через взаимную ёмкость и

индуктивность. Кроме того, значи�

тельные токи и резкие фронты

приводят к увеличению уровня

электромагнитного излучения и,

следовательно, перекрёстных по�

мех;

● колебания в шине заземления. Коле�

бания в шине заземления, вызван�

ные избыточным током (или сопро�

тивлением источника питания и

возвратных путей по заземлению),

могут вызвать смещение опорного

уровня схемы при протекании боль�

ших токов.

Многие из перечисленных проб�

лем можно обнаружить и исправить,

используя модуль Signal Integrity в

программе Altium Designer. Так можно

обнаружить два главных источника

шумов и взаимных помех в высоко�

скоростном печатном монтаже: отра�

жения (Reflection) и перекрёстные по�

мехи (Glosstalk). Анализ целостности

сигналов в программе Altium Designer
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можно выполнить на этапе схемы

(предтопологический анализ) и на

этапе платы (посттопологический).

Причём в первом случае программа

не учитывает расположение печат�

ных проводников по слоям и ис�

пользует усреднённое значение для

длины и волнового сопротивления

проводников. На схемном уровне

устранение проблем, связанных с

целостностью сигналов, происхо�

дит путём согласования линий пере�

дачи и входных/выходных сопро�

тивлений микросхем. Рассмотрим по

отдельности оба представленных

выше подхода.

ПРЕДТОПОЛОГИЧЕСКИЙ АНАЛИЗ

Для знакомства с основными эта�

пами проведения анализа целост�

ности сигналов в Altium Designer

воспользуемся демонстрационным

проектом, который поставляется в

составе установочного диска и рас�

положен в директории …Program

Files\Altium Designer Summer 09\Ex�

amples\Signal Integrity\Spirit Level.

Откроем из этой директории файл

Signal Integrity.DsnWrk, который пред�

ставляет собой группу из четырёх

проектов. Начнём с проекта SCH Is�

sues.PrjPcb и откроем главную схему

проекта.

Анализ целостности начинается с

выполнения команды Tools > Signal

Integrity, при этом могут быть сооб�

щения о том, что не все модели име�

ются в наличии и что необходимо

задать усреднённую длину проводни�

ков. Оба эти шага при появлении сле�

дует пропустить (в первом случае

нажатием кнопки Continue, во вто�

ром – Analyze Design), т.к. эту инфор�

мацию можно задать через панель

Signal Integrity (рис. 1), которая по�

явится далее.

В левой части панели Signal In�

tegrity показан список цепей, для ко�

торых проводился анализ. Это те це�

пи, которые объединяют компонен�

ты с подключенными IBIS�моделями

(о подключении моделей будет сказа�

но отдельно в конце статьи). Если

найти в списке цепь с названием

DONE, то можно обнаружить, что для

неё рассчитанное значение Rising

Edge Overshoot (максимально допус�

тимый положительный выброс на

переднем фронте сигнала) значи�

тельно превышает аналогичные зна�

чения для других цепей. Выбираем

левой клавишей цепь DONE и добав�

ляем её в правый список, как показа�

но на рисунке 1. После этого справа

под списком цепей (где сейчас ука�

зана только одна цепь DONE) можно

увидеть все выводы, которые соеди�

няет эта цепь. Убедившись, что в

списке Termination (согласованная

нагрузка) выбрана опция No Termi�

nation, запускаем анализ кнопкой Re�

flection Waveforms.

Результатом анализа будет отобра�

жение трёх графиков, и чтобы их

проанализировать, можно временно

закрыть панель Signal Integrity. Гра�

фики (рис. 2) показывают форму сиг�

нала на источнике сигнала и двух

приёмниках, причём из графика вид�

но, что на выводе микросхемы U6

имеются довольно большие выбросы,

которые могут повлиять на правиль�

ность работы схемы. Под выбросами

понимаются минимальные и макси�

мальные напряжения, имеющие мес�

то после переключения сигнала меж�

ду логическими уровнями. Такие выб�

росы являются следствием отражения

сигнала из�за неправильного согла�

сования. Недостатком предтопологи�

ческого анализа является отсутствие

возможности задать предельно допус�

тимые значения для выбросов сигна�

лов (это можно сделать лишь на уров�

не платы).

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ
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Рис. 2. Результат моделирования сигнала DONE с характерным «звоном» вследствие отражения

Рис. 1. Панель Signal Integrity используется для запуска моделированияе
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Для устранения данной проблемы

следует выполнить согласование [2],

которое можно промоделировать в

Altium Designer. Не покидая результа�

тов моделирования, вызываем панель

Signal Integrity через кнопки вызова

панелей в правом нижнем углу (Editor

> Signal Integrity). В правой части вы�

бираем узел, на который необходимо

установить согласующий элемент (в

нашем случае U6, см. рис. 1), и выби�

раем вариант Serial Res (Последова�

тельный резистор) в разделе Termi�

nation. Включаем опцию Perform

Sweep, указав разброс резистора от 0

до 100 Ом с шагом 10 Ом, и запускаем

повторный анализ нажатием кнопки

Reflection Waveforms. Теперь на каж�

дом из трёх графиков показано по 11

сигналов, соответствующих разны�

ми значениям согласующего резис�

тора. По полученным результатам

(см. рис. 3) видно, что наиболее сгла�

женные фронты сигна�ла получают�

ся при величине согласующего ре�

зистора 44,44 Ом (естественно, ре�

зистора с таким номиналом не

существует, и будет использован бли�

жайший из доступного ряда, т.е. 

47 Ом).

В качестве примера откройте второй

проект (SCH Issues Resolved.PrjPcb) и

ознакомьтесь с результатами анализа

целостности. Обратите внимание на

согласовочный резистор Rdone, кото�

рым корректируется выброс сигнала,

полученный при анализе первого про�

екта.

Рассмотренный проект был пол�

ностью подготовлен и наглядно де�

монстрирует подход к оценке целост�

ности сигналов на схемотехническом

уровне. Однако в реальном проекте

разработчику придётся выполнить ряд

обязательных действий, которые в де�

монстрированном проекте уже отла�

жены. Речь идёт о следующих процеду�

рах:

● добавление IBIS�моделей для компо�

нентов;

● описание цепей питания и земли;

● описание цифровых сигналов;

● настройки анализа целостности сиг�

налов.

Кратко рассмотрим описанные

действия; они могут быть выполнены

разными способами, но удобнее всего

решать эти задачи средствами пане�

ли Signal Integrity. Панель Signal In�

tegrity может быть запущена через ме�

ню Tools или через кнопки вызова па�

нелей в правом нижнем углу (если

процесс моделирования уже выпол�

нялся). Добавление моделей к компо�

нентам выполняется через специаль�

ный диалог, который вызывается на�

жатием кнопки Model Assignments (см.

рис. 1). Каждому компоненту назна�

чен определённый статус модели, как

показано в табл. 2. Чтобы подключить

модель, через диалог Model Assign�

ments следует выполнить следующие

действия:

● выбираем компонент, которому не�

обходимо назначить модель;

● выбираем тип компонента. Для

анализа целостности сигналов

имеются семь различных типов

компонентов – resistor (резистор),

capacitor (конденсатор), inductor

(катушка индуктивности), diode

(диод), BJT (транзистор), connec�

tor (разъём) и IC (микросхема). Тип

каждого компонента может быть

выбран в выпадающем меню пер�

вого столбца или через двойной

щелчок мыши;

● для резисторов, конденсаторов и ка�

тушек индуктивности задаётся но�

минальное значение (Value). При

возможности это поле будет запол�

нено автоматически из параметров

компонента;

● для микросхем выбирается техноло�

гия изготовления, которая является

определяющей характеристикой для

выводов модели, используемых при

моделировании. Технология задаёт�

ся в выпадающем меню в столбце

Value/Type;

● наиболее корректным способом

для микросхем является импорт

IBIS�модели микросхемы, постав�

ляемой производителем. Такую мо�

дель можно подключить, выпол�

нив двойной щелчок на строке

компонента после выбора для него

типа IC;

● в завершение описанных действий

нужно выполнить сохранение на�

значенных моделей, используя

кнопку Update Models in Schematic
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Рис. 3. Результат моделирования сигнала DONE с подбором согласующего параллельного резистора
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в диалоговом окне Model Assign�

ments.

Подключенные описанным спосо�

бом модели будут актуальны только в

текущем проекте, и если планирует�

ся использовать такие же элементы в

других проектах, то более правиль�

ным способом будет подключение

IBIS�моделей на этапе создания би�

блиотек. О подключении моделей в

библиотеках было подробно напи�

сано в одной из предыдущих ста�

тей [6].

Прежде чем запускать анализ це�

лостности сигналов, программе

требуется указать номинальные зна�

чения уровня земли и питания, а так�

же задать параметры воздействую�

щего сигнала. Все эти значения за�

даются через меню Setup Options,

которое доступно в контекстном ме�

ню при нажатии правой клавишей

на списке цепей (см. рис. 1). Здесь на

вкладке Supply Nets необходимо вы�

ключить опцию Use rules defined in

Schematic/PCB и указать для цепей

питания и земли их цифровые зна�

чения. В качестве альтернативы это

можно сделать на схеме или плате,

используя директивы (Place > Direc�

tives), но это менее удобно. На вклад�

ке Stimulus диалогового окна Setup

Options указано значение воздей�

ствующего сигнала, который опре�

деляет порядок частот работы схе�

мы. Воздействующие сигналы могут

быть различны для разных участ�

ков схемы, поэтому их удобнее за�

дать с помощью команды Place > Di�

rectives > Stimulus. В качестве приме�

ра можно ознакомиться с заданными

сигналами DRV_N и DRV_P в проекте

SCH Issues.PrjPcb. Последнее, что за�

даётся в диалоге Setup Options –

вкладка Track Setup, это усредненное

значение длины дорожки и значение

её импеданса Эти опции задаются

только при предтопологическом

анализе!

ПОСТТОПОЛОГИЧЕСКИЙ

АНАЛИЗ

Для проведения моделирования це�

лостности сигнала на уровне печатной

платы система Altium Designer имеет

функцию анализа целостности сигна�

лов на уровне проверки правил проек�

тирования (DRC). Отметим, что эта

функция отсутствует в стандартном

наборе инструментов всех остальных

систем проектирования печатных

плат.

Для мониторинга целостности сиг�

налов в системе Altium Designer име�

ется специальный набор правил про�

ектирования, задающих критерии

оценки различных параметров платы

по итогам моделирования. Эти прави�

ла сгруппированы на вкладке Signal In�

tegrity диалогового окна Design Rules,

вызываемого командой Design > Rules

редактора печатных плат (см. рис. 4). В

общем случае в проекте может быть

назначен практически неограничен�

ный набор правил проектирования с

различной областью действия (от от�

дельной цепи до всей платы) и прио�

ритетом.

В число правил проектирования,

учитываемых при анализе целостнос�

ти сигналов, входят:

● Impedance Constraint – определяет

минимально и максимально допус�

тимый импеданс цепи;
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Рис. 4. Определение правил проектирования для анализа целостности сигналов

Таблица 2. Статус модели в диалоге Model Assignments

Статус Описание

No match
Диалог Model Assignments не смог обнаружить ссылку на какой�либо конкретный тип модели

для данного компонента. Возможно, пользователю придётся установить модель вручную

Low confidence В диалоге Model Assignments определён тип компонента, но заданы не все данные

Medium confidence В диалоге Model Assignments определён тип компонента, и имеется минимально необходимый набор данных для предполагаемой модели

High confidence В диалоге Model Assignments определён тип компонента, и заданы все необходимые характеристики для компонента данного типа

Model found Для данного компонента найдена модель

User modified Такой статус появляется у компонента после ручного редактирования дополнительных характеристик модели

Model added Такой статус появляется при добавлении к компоненту ссылки на новый файл IBIS�модели
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● Overshoot – Falling Edge – опреде�

ляет максимально допустимый от�

рицательный выброс (затухающие

колебания относительно низкого

значения напряжения) на заднем

фронте импульса сигнала;

● Overshoot – Rising Edge – определяет

максимально допустимый положи�

тельный выброс (затухающие коле�

бания относительно высокого зна�

чения напряжения) на переднем

фронте сигнала;

● Signal Base Value – определяет

максимально допустимое значе�

ние напряжения сигнала низкого

уровня;

● Signal Flight Time Falling Edge – опре�

деляет максимально допустимое

время задержки заднего фронта сиг�

нала;

● Signal Flight Time Rising Edge – опре�

деляет максимально допустимое вре�

мя задержки переднего фронта сиг�

нала;

● Signal Stimulus – определяет ха�

рактеристики входных сигналов,

которые используются при анали�

зе целостности сигналов. Это сиг�

налы, которые подаются на каж�

дый входной вывод тестируемой

цепи и формируются на выходных

выводах. Во время проверки пра�

вил проектирования возвращает�

ся наихудший возможный резуль�

тат;

● Signal Top Value – определяет ми�

нимально допустимое значение

напряжения сигнала высокого

уровня;

● Slope – Falling Edge – определяет мак�

симально допустимое значение кру�

тизны заднего фронта импульса. Под

этим значением здесь подразумева�

ется время, затраченное на измене�

ние уровня сигнала от порогового

напряжения (VT) до действительно�

го значения напряжения низкого

уровня (VIL);

● Slope – Rising Edge – определяет

максимально допустимое значе�

ние крутизны переднего фронта

импульса. Под этим значением

здесь подразумевается время, за�

траченное на изменение уровня

сигнала от порогового напряже�

ния (VT) до действительного зна�

чения напряжения высокого уров�

ня (VIH);

● Undershoot – Falling Edge – определя�

ет максимально допустимое значе�

ние положительного выброса (зату�

хающие колебания относительно

низкого значения напряжения) на

заднем фронте сигнала;

● Undershoot – Rising Edge – опреде�

ляет максимально допустимое

значение отрицательного выбро�

са (затухающие колебания относи�

тельно высокого значения напря�

жения) на переднем фронте сиг�

нала;

Следует помнить, что данные пра�

вила не контролируются при инте�

рактивной трассировке, а использу�

ются только при проверке DRC в па�

кетном режиме. Для того чтобы

использовать эти правила, необходи�

мо обязательно установить правила

Signal Stimulus Rule и Supply Nets rules

(о чём было сказано в предыдущем

разделе).

При запуске программы пакетной

проверки правил проектирования

DRC необходимо включить контроль

всех необходимых правил из числа

назначенных. Это производится в

окне Design Rule Check, где после на�

жатия на кнопку Signal Integrity откро�

ется специальное окно Design Rules с

активными опциями, соответствую�

щими назначенным наборам правил

(рис. 5). После включения всех необ�

ходимых опций следует запустить

процедуру проверки нажатием кноп�

ки Run DRC.

В ходе проверки будет сформиро�

ван отчёт, в котором в виде списка
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Рис. 5. Настройка проверки правил проектирования

© СТА�ПРЕСС



нарушений будет констатироваться

наихудший случай. Следующим эта�

пом работы над проектом будет уточ�

нение места, где возникло наруше�

ние правила проектирования. Для

этого следует запустить программу

анализа целостности сигналов, вы�

брать упомянутую в отчёте цепь и

промоделировать распространение

сигналов в ней. В случае нарушения

допустимых значений импедансов

моделирование может не потре�

боваться – достаточно будет изме�

нить ширину проводников указан�

ных цепей.

Кроме того, что в редакторе печат�

ных плат проверка целостности сиг�

налов является частью проверки DRC,

для верификации и отладки участков

платы, не удовлетворяющих правилам,

используется панель Signal Integrity,

как и в редакторе схем. Рассмотрим

ещё один пример, который идёт в

комплекте с программой и наглядно

демонстрирует особенности анализа

целостности на уровне платы.

Откроем проект Examples\Signal In�

tegrity\SimpleFPGA\SimpleFPGA_SI_De�

mo.PrjPCB и откроем плату этого про�

екта. Внешний вид топологии, с из�

лишними изгибами и удлинёнными

параллельными участками, уже на�

водит на мысли о возможных пробле�

мах. Для данного проекта были зада�

ны правила проектирования (De�

sign > Rules), и можно приступить к

анализу: Tools > Signal Integrity. Как и в

случае с предтопологическим анали�

зом, игнорируем сообщение, что не

все компоненты содержат модели, и

получаем результат в виде панели Sig�

nal Integrity. Здесь розовым показаны

цепи, для которых контролируемые

значения превышают заданные в пра�

вилах нормы. Например, найдём цепь

D7 и, нажав на ней правой клавишей,

выберем команду Cross Probe > To PCB,

в результате чего проблемная цепь бу�

дет показана на плате. Топология

этой цепи далека от идеала, и если,

например, оптимизировать эту цепь,

заменив меандр прямой дорожкой, то

будут получены следующие результа�

ты для максимально допустимого

значения положительного выброса

на заднем фронте сигнала 299,7 мВ

(было 679,5 мВ). То есть теперь по это�

му параметру топология удовлетво�

ряет требованиям проекта, но топо�

логию нужно далее редактировать,

чтобы привести в норму другие ха�

рактеристики. Полные результаты
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Рис. 7. Настройки для анализа перекрёстных помех

Рис. 8. Результат моделирования перекрёстных помех

Рис. 6. Результаты моделирования цепи D7 до и после редактирования
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анализа можно получить, нажав пра�

вой кнопкой мыши на названии цепи

и выбрав Details (см. рис. 6).

Чтобы провести анализ перекрёст�

ных помех, нужно первым делом

определить цепи, которые являются

парными для выбранной цепи. Воз�

никает вопрос: какими характерис�

тиками руководствоваться при дан�

ном поиске. Здесь стоит опять же об�

ратиться к теории [2, 4], где говорится,

что перекрёстная помеха возникает

из�за возвратных токов по экрану пи�

тания, а если быть совсем точным, то

из�за плотности этогих токов. При�

чём эта плотность меняется по экс�

поненциальному закону и макси�

мальна под проводником, а стано�

вится практически не значимой на

удалении трёх толщин проводника.

Соответственно, чтобы задать пара�

метры, определяющие парные цепи,

необходимо в контекстном меню

выбрать Preferences (см. рис. 7) и на

вкладке Configuration задать макси�

мальное расстояние, на котором до�

рожки создают перекрёстные поме�

хи (Max Dist) и минимальную длину

(Min Length). После этого выбираем в

контекстном меню Find Coupled Nets,

в результате чего будут подсвечены

все парные цепи (при установке зна�

чений в соответствии с рис. 7 будут

выделены три цепи). Добавляем эти

цепи в список для моделирования (в

правой части), правой клавишей на�

значаем цепь D0 агрессором (источ�

ником помехи), после чего две дру�

гие цепи автоматически становятся

жертвами. В результате назначения

агрессора становится активной кноп�

ка Glosstalk Waveforms, позволяющая

запустить анализ перекрёстных по�

мех.

На рис. 8 показаны результаты моде�

лирования перекрёстных помех в ви�

де сигнала на источнике помехи и

уровня помехи на проводнике�жерт�

ве. Если уровень помехи превышает

уровень установки цифрового значе�

ния, то на проводнике�жертве прои�

зойдёт ложное срабатывание, и уст�

ройство будет работать некорректно.

В нашем случае порядок помехи изме�

ряется в десятках милливольт, по уров�

ню этой помехи можно делать выводы

о работоспособности платы и при не�

обходимости вносить правки в топо�

логию.

Модуль Signal Integrity не позволя�

ет решить все задачи по обеспече�

нию электромагнитной совместимос�

ти и целостности сигнала, и для более

серьёзных задач рекомендуется ис�

пользовать специализированные про�

граммы (HyperLinx и др.). Плату, разра�

ботанную в программе Altium Designer,

можно сохранить в формате HyperLinx

с помощью команды File > Save As.
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